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1. Introduction

WordPress is a Content Management System (CMS) that allows content contributors to easily create, update,
manage and publish website content. It is widely regarded as one of the easiest and most user-friendly content
management systems with many similarities to typical word processing programs.

This is your guide that outlines basic content editing processes.

Note: Some websites have content contribution roles set up according to workflow functions, that
can enable them to either ‘Publish’ content or ‘Make Revision’ to gain approval prior to being
published.

1.1 Web design guidelines

Curtin websites are created according to the University’s design guidelines. This includes the way content
is written, and the way it appears. Site editors and publishers are encouraged to browse through Curtin’s
websites to gain an understanding on how design elements and webpage building blocks (or page modules)
are used, as well as to familiarise themselves with our web writing and style guides available on the Web
Toolkit page:

http://web.curtin.edu.au/

1.2 Access & login

Once you obtain your role as a content contributor, you will be able to use your staff login credentials to access
the website you wish to edit.

Once you are logged in, you will be able to see a black or grey bar that appears at the top of your web page.
This bar is called the Admin or Action Bar and it is an easy-to-access toolbar with a few shortcuts to WordPress
Dashboard or to edit a page.

If you can see the ‘Edit Page’ button, your content contribution access is enabled. If you can’t see this button,
you will not be able to modify the page.

tfi A% MySites @ Staff Portal [Staging] < New g% Edit Page STAFF PORTAL [STAGING]

Curtin University Quick Links v

Figure 1.1 — WorPress Admin Bar


http://web.curtin.edu.au/

2. Home page

Figure 2.1 demonstrates editable areas on Curtin’s Future Students website. All pages within the CMS are
made up of various elements and content blocks also known as page modules. Access to a home page is
usually restricted to site editors.

Find a course, unit or MOOC

Browse all offerings

How to apply

——= Search module

assistance and fees

A scholarship or other form of financial
istance from Curtin or the Ausiralian
mment can help you pursue your

Scholarships, financial

Other admission
pathways
If you don't meet our admi crites

are still plenty of ways to gain entry
such as portfolio entry and enabling

Years 10-12, it's
r plans for uni

understand enrolment, course selection and all

the fun stuff

‘Spotlights’ page
module with custom
images, text and a call
button.

Aboriginal and Torres Strait Islander
students

At Curtin, you're encouraged to take control of your own
learning with an enduring sense of belonging, autonomy
and strength. There's a variety of financial and study-
related resources and support services available to
assist you

FIND OUT MORE

Figure 2.1: Home page elements of futurestudents.curtin.edu.au

Regional study

Pursuing your study journey can often mean relocating to
acily centre. Curtin offers a range of courses at regional

campuses and online, giving you the flexibility remain at

at home while you study

FIND OUT MORE

—— Editable text

}—~ Call to action button



3. Gateway pages

A gateway, or a landing page is a top-level page of a site section. This is an overview page that uses page
modules with functionalities such as links to child pages, course search, social media feeds or content
promotion. These pages are usually just used for Level 1 or Level 2 gateway pages that showcase and surface
relevant content from a site section. Like the home page, these pages are restricted to site editors.

Currm University Lbrary Currentsiudents Student OASIS  Staff Portal

CurtinePay Campusmap Contactus SEARCH

HOME ABOUT - FUTURE STUDENTS STUDY + RESEARCH ALUMNI & GIVE ~ ENGAGE HOW TO APPLY

Home > Future students > Years 10-12

@ Feedback

Years 10-12

If you are in Years 10-12, it's time to start thinking about your plans for uni. We have all the information you need to help you understand enrolment, course selection and
all the fun stuff

| am a student | am a parent | am a teacher

More than study awaits you at Curtin Choosing the right universi attend is one of the most exciting

m a great range of and important decisions your child will make

course options, plus join in with the many events happening
across our campuses

Are you a school principal, t
coordinator who is involved with ac
During your child’s final school years, it's important to help, stidy? Looko further, w
support and guide them through their options, so they can begin

their university career with confidence.

Coming to Curtin means you get to ch

Studentbox

Uni terms explained
A network to help you get through high school and ino

uni. Find answers, ask questions, and connect with our
online community of high school students in WA

Gonfused by all the 'Uni-lingo’ look no further. We have a
comprehensive list of commonly used uni terms.

FIND OUT MORE
Community discussions

>
Study tips. >
Revision resources >

REGISTER NOW

Find a course

Browse all offerings  How to apply

Figure 3.1: Landing page demonstrating elements of futurestudents.curtin.edu.au — first half of the page.



FEATURED STORY

First scholarship winner hopes
to follow in Julia Gillard's
footsteps

One of Western Australia’s brightest high school graduates is
the inaugural recipient of the Julia Gillard Women in
Leadership Scholarship to study at Curtin University.

YOU MAY ALSO LIKE

Why choose Curtin

At Curtin we have globally recognised courses and extensive industry connections. You'l be immersed in
technology-rich environments and inspired by
innovation, creativity and high-impact research. >

CLICK TO READ MORE...

Visit our online support centre for questions on offerings, admission criteria, bridging and enabling courses. Anything Curtin
course related, we can answer it.

Curtin Connect Future Students

Contact hours: Monday to Thursday 8.30 am — 4.30 pm
and Friday frem 10.00 am — 4.30 pm (excluding public
holidays)

Phone: 1300 222 888

International Student Services
Contact hours: Monday to Friday from 8.00 am — 5.00 pm
(excluding public holidays)

Phone: 1300 222 888 (select options 2-2-1) or +61 8 9266
5888 (if calling from overseas)

Support for Australia and New Zealand
Students

Support for International Students >

Figure 3.2: Landing page elements of futurestudents.curtin.edu.au — bottom half of the page.



4 . Standard pages

4.1 Main content, navigation and sidebars

Figure 4.1 shows the location of main menu, section navigation, main content area and the right sidebar.
The most important information must be displayed in the main content area marked in red.

The sidebar, shown in blue, should be related to the main content, but not of primary importance. Items
such as Related links are displayed here.

The main menu is displayed on the top of the page (magenta). On hover, the menu will reveal the second
level of navigation (see Figure 4.2). The full hierarchical menu is available through the section navigation
displayed on the left of the page. This area is used to priorities the most used/most important pages within
that section.

Note: You can opt to hide the left navigation depending on each section’s design requirements.

Curtin University

Library Current students  Student OASIS ~ Staff Portal Curtin ePay Campus map ~Contact us

LCurrent students  Student OASIS  Staff Portal  Curtin ePay SEARCH
Top
- t HOME ABOUT + FUTURE STUDENTS STUDY + RESEARCH ALUMNI & GIVE ENGAGE HOW TO APPLY
Home > Fulure students > Undergraduste > Admission pathways > Enabing programs > UriReady Enabing Program
CGSB MBA Information Evenings UniRead y Enabli ng Prog ram Howioaptiy N
‘Why choose Curtin
e Successfully completing this short entry pathway program can qualify you for a range of undergraduate sk >
urtin life
degrees at Curtin — and you can study it on campus, fully online, or a combination of both. B — 3
Years 10-12
Undergraduate About UniReady v
Applicants with recent secondary R — < Related links E
education « Apply through TISC 3
Applicants with higher education Courses this can lead to ¥ « Academic calendar =
Applicants with vocational education Eoitadius G « How university differs from school
and training study
Applicants with work and lfe experience | | ;4 o, finish secondary school more than two years ago and want to go to uni, but aren't sure how to begin e e R
ni terms explaines
Domestic applicants with overseas the process? Learn how the UniReady Enabling Program can help you gain entry to the course you want, at E
qualffications our UniReady Mature Age Information Sessions.
Admission pathways
LEARN MORE
L e ft Portfolio entry
navigation SiepUpte iy Right side bar
Special consideration A :
pplying for UniReady

Enabling programs
| UniReady Enabling Program
Curtin College

Higher Education Diploma of
Commerce — North Metropolitan TAFE

TAFE (VET) or other AQF
qualifications

Student profile

ATAR profile
Postgraduate by coursework
Higher degree by research
International applicants
Regional study

Aboriginal and Torres Strait Islander
people

Credit for recognised learning (CRL)
English language proficiency

Scholarships, financial assistance
and fees

Help and FAQ's

There are two types of students studying UniReady, Contribution Exempt students who are in a fully
government funded place and pay no student fees, and Domestic Fee-Paying students who have chosen to
pay for the course. The government provides a large number of Contribution Exempt places every year, so
most students who undertake UniReady do not pay any course fees. There are Contribution Exempt places
set aside for each semester. Applications for Contribution Exempt places open first, and once all places for
that semester are filled, applications for Domestic Fee-Paying places will open

UniReady encourages all students to apply for a Contribution Exempt place first, and to consider the
Domestic Fee-Paying option should they not be successful in receiving a Contribution Exempt place
Application dates and processes for the Contribution Exempt and Domestic Fee-Paying places are different,
and can be found below.

If you have been offered a place in UniReady and you are unsure if you are Contribution Exempt or
Domestic Fee-Paying you can check the ‘Liability Category’ on your Letter of Offer.
Contribution Exempt Places

Contribution Exempt places are fully Commenwealth supported, and students are not required to pay any
fees. We recommend all students apply for a Contribution Exempt place.

How to apply v
How much will it cost? v

Domestic Fee-Paying Places

Domestic Fee-Paying places are not Commonwealth supported and students must pay fees. Apply for a
place in the Domestic Fee-Paying course if you were in receiving a C:
but would stilllike to study UniReady.

1 Exempt place

Main content area

Figure 4.1: Location of main and additional content (red) and secondary content (blue) areas



CURTIN WEB DESIGN FRAMEWORK

Hiorma [ ] SAruciune Dasgn compongnts

Torminology
Liser expastance

esigned and built for
Curt Csality Assurance

Browser and devios suppcr s beon dasigned for making Curtin University

LN Braakpoints without reinventing the wheal

Cading practica ing and improving the framework. If you wish o | ——

use the § at you nead 1o get the process started.
Branding ¥ o P " l
o =
v
Curtin University logo L _l
=]

Colour paletia F. |

Second level of navigation accessible as single drop downs

Figure 4.2 Top navigation / main menu revealing succeeding second level child pages

4.2 Section navigation
The section navigation is related specifically to the section of the website displayed in the section title.

On the desktop and landscape tablet it is situated on the left side of a content page by default; on a mobile
and portrait tablet view it is collapsed into an expandable menu accessible via the ‘hamburger’ icon
positioned next to the section title.

The section navigation expands three levels on all screens. This decision has been made to reduce the
complexity of hierarchical menus and allow for content to be simplified for easy reading on all screens.

Who we are
Vice Chancellor's welcome
Traditional Aboriginal welcome
Vision, mission, & values
Vision for 2030
Abaoriginal Reconciliation Action Plan
LGBTI Support

Curtin Values

Curtin leadership
Figure 4.3 Left navigation



5. The WordPress Dashboard

The Dashboard is the main administration home page which is essentially the ‘back-end’ of the website.

Figure 5.1 below shows all the areas available for a site content editor:

& MySites @ Staff Poral [Staging] < Mew STAFF PORTAL [STAGING]

£ Workdfiows Copy of - Search Portal - WORKFLOW CO
@8 Dashboard
Copy of — Home — WORKFLOW COR
# ezdership developmen
L campu
* mployrnent
* zllbeing
Copy of - campus — WORKFLOW COP
Copy of - Wellbeing — WORKFLOW CO2
» earning & teaching
Copy of - ployment — WORKFLOW CC
- Rezearch

Figure 5.1 WordPress Dashboard and page tree

Media Library

The Media Library is where all images and documents are stored. Content editors are able to browse
through the Media Library in order to edit as well as update any files that have been stored there.

Pages
The Pages section is where all website pages are created and updated.
When you select All Pages from your menu, you will be able to see the structure of your website (Figure

5.1). You can edit pages from this view, and you can choose to view pages according to a selected category.
This view mirrors your site’s navigation and hierarchy.

Note: If you click on a page you don’t have editing access to, this page will simply reload. If you have
access, you will be taken to the selected page’s editing view.



6. Editing a page

Below are the content elements of a standard web page. This includes the areas to input / edit your title,
web page text, add page or sidebar modules, show banners and add media and attachments.

6.1 Page options

In the editing window, you will see a Page Options area you can expand or shrink depending on the sections
where you would like to work (See Figure 6.1 for expanded view, or Figure 6.4 when shrunk).

This section contains four tabs where you can control sidebar and heading content:

e Heading

e Other options

e Banner

e Sidebars
Heading

Heading tab allows you to update title, optional header content and header links (Figure 6.1). You can add
/ change banner overlay colour for banner images and videos (see background colour in Figure 6.1).

f_j A% MySites (@ Staff Poral [Staging] 4= New View Page STAFF FORTAL [STAGING]
o UL Edit Page
@ Dashboard _

Copy of - Training demo page - WORKFLOW COPY Page title
A Posts N N N - —

Permalink: http://staffportsl-stg.curtin edu.au/employment/copy-of-training...-workflow-copy-2/| Edit
3 News
f] Events Pegeoptions  Page options X
‘-,4_.- VC's blag Heading Other options Banner Sidebars
2 Media

Page Headings
W Pages

Subtith
= ubtitle
onal - disp
Ta
4
A
& TablePress
* Profile Links Background Colour Display
Links appear beneath the content. Background colour for title & subtitle Display heading title / subtitle
Link Elack -
sdusu/zmpl
‘oyment/con x
Background colour

Adding a link

Figure 6.1 Heading tab
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Banner

Banner

tab allows you to add / update your page banner. You can select to use an image or call-to-action

(CTA) items.

b ites §§ Staff Porial [Staging] 4+ New View Page STAFF PORTAL [STAGING]

£F Workflows
@ Dashboard
A Posts

S\ News

7% VCsblog
2 Media
B Pages

Al

& TablePress

as Profile

[+]

Figure 6.

Edit Page

Copy of - Training demo page - WORKFLOW COPY

Permalink: http//staffportal-stg.curtinedu.su/employment/copy-of-training...-workflow-copy-2/ | Edit

Page Options
Heading Other options Banner Sidebars
Page Banner

Type Banner Size Vertical Alignment Image *

Position/alignment o
None mage + CTA | Video | Colour | Small Large

within the banner.

2 Banner tab

Sidebars

Sidebars tab allows you to edit the following:

Show/hide left sidebar
Show/hide right sidebar
Show/hide page navigation in the left sidebar
Apply to children — enabling this function ensures that all child pages inherit all parent page options.
This could be useful if you would like for all child pages to:
o display a content box with same information in the right sidebar
o optto hide left navigation

Note: if you would like to have one of these elements to appear differently on one of the child
pages, do not enable this function.

fi Swff Portal[Saging] < New View Page STAFF PORTAL [STAGING]

L& Workdiows

@ Dashboard

& Profile

o

Edit Page

Copy of - Training demo page - WORKFLOW COPY

Parmalink: bt rial-stg.curcinsdu au/emplo

Page Options

Heading | | Other options | | Banner || Sidebars

Sidebars

e e -

Sidebar modules Siebar modules

1 Content Box

+ Add sidebar module

Figure 6.3 Sidebar tab
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6.2 Categories, Tags, Page Attributes and Featured
Image

Note: These features are restricted to some site editor roles, and are located on the right-hand
side.

6.2.1 Categories and tags

Categories are used for broad grouping of posts. Think of these as general topics that can help identify
your post, and can help improve your site’s search engine optimisation (SEO). These can be used to group
news, events or forums. Categories are hierarchical.

Categories &
—
I.ﬂ Categoriesf Maost Used

V| Mews
Curtin IT
Events
Faculty of Health Sciences
Forum
Health & wellbeing
Learning & teaching

pagely-test ad
+ Add New Category
Figure 6.4 Categories

Tags are meant to describe specific details of your posts. Think of these as your site’s index words. They
are micro-data that you can use to micro-categorise your content and can improve your site’s SEO. Tags
are not hierarchical.

You can refer to the online WordPress beginners guide for more information about categories and tags.

6.2.2 Page attributes

You can determine the parent of your page in the Page Attributes area, as well as the order it appears in
the navigation.

Page Attributes 4
Parent

Services ¥
Order

10

Meed help? Use the Help tab above the

zcreen title.

Figure 6.5 Page attributes
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https://www.wpbeginner.com/beginners-guide/categories-vs-tags-seo-best-practices-which-one-is-better/

6.2.3 Featured image

Featured image is used to identify your page, when listed. These are particularly useful when listing news

and events items on the web page.

Click the image to edif or update

Remove featured image

Featured Image A

Figure 6.6 Using featured image

All news

2019 Curtin Learning and Teaching Grant recipients
Monday, 10 December 2018 Leaming & teaching, News
Twenty learning and teaching projects to be funded in 2019

Curtin community helps women in need

Monday, 10 December 2018 News

Through the generosity of many Curtin staff, essential goodies have been donated
to the Share the Dignity 2018 campaign.

Update on staff and alumni giving 2018

Monday, 10 December 2018 News

University Advancement is pleased to provide an update on the Alumni Annual
Appeal and staff giving program, Give to Change.

Share an Aussie Christmas Day
Monday, 10 December 2018 MNews

External Review of Academic Governance
Monday, 10 December 2018 MNews
Cutcomes of the External Review of Academic Governance

13



6.2 Editor modes and toolbars

The Editor is also known as the WYSIWYG (What you see is what you get) page module. There are two
editing modes available, depending on which you are most comfortable with:

e Visual Editor

e Text Editor

Visual Editor mode

This is a default mode and looks very similar to a word processor. The Visual Editor icons (widgets) allow
you to format text, change font alignment, insert bulleted and numbered lists, create tables, add media and
links. The editor toolbar contains all the formatting elements that you need.

Add New Page

Enter title here  VWeb page title

Page Options Page Optlons
o i Editor toolbar ——
Filev Editv Vieww Insertv Formatv Toolsw Table v

paragrsph v B I 66 E v E v =

Formasw & | B 0 QO B A v Hr @

f 8N =R

Enter your content herel Standard web page text

Word count: 4

Yoast SEO v

Page Modules Page moduieS -

Modules

Click the "Add page module” button below to start creating your layout

# Add page module

Figure 6.7 WordPress Editor

Text Editor mode

The Text Editor has fewer options, but allows you to write your posts in HTML. This editing mode is aimed at
users who are comfortable working with mark-up language. When you need to add a different font style, or
paste in code from an outside source, you can use the Text Editor.

Switching Editors

Switching between the visual and text editing modes is easy. Just use the tabs directly above the right side of
the editing area.

You can find out about benefits and implications of switching between the editors in the WordPress manual.

14


https://make.wordpress.org/support/user-manual/content/editors/

6.3 Editor toolbar options

The Visual Editor toolbar contains options to add media, perform formatting functions, draw tables, add
links, emails or anchors. Most formatting widgets (bold / italic text, lists, links, etc) are visible in the toolbar
(see Figure 6.8). If you can’t locate the widget you would like to use, try checking under ‘Insert’ or ‘Format’
menu functions (see Figure 6.9). The top menu replicates all widget functions.

Note: The appearance of widgets is customised according to the WordPress theme updates
performed by admin, and can be subject to minor changes.

Content - wysiwyg

Content

% sddmeda | | Add Media button

File » Edit+ \iew Insert+ Format~ Tools+ Table »

Paragraph * B I 6 = E»= & = S8 2 v
Fomats 2 B R Q¢ O = A~ H- @
Figure 6.8 Visual Editor toolbar
Content Content
83 Add Media 87 Add Media
File  Edit* WView » | Insert « | Format v Tools v Table » File ¥ Edit+ WView~ Insert~ | Format & | Tools ¥ Table »
Paragraph *rx B (? Insert/edit link = = GQ Paragraph *x B I ¢ B Bold + ag & Tl g
Formats * = 3* E B3 Media r @ Formats v € T B ¢ ( I ilic
F Table b U Underline

Q Special character #p¢ Strikethrough

= Horizontal line X" Superscript

¥, Subscript

ot Nenbreaking space
= <> Code
i Anchor

Blocks 4

Date/time s

Align 4
Q7 Add Media
= Insert Read Mare tag & Clear formatting

M Page break

Figure 6.9 Visual Editor menu
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6.3.1 Add Media

Use the ‘Add Media’ button to insert documents and images from the Media Library (see Figure 6.8), or
upload new media attachments from your computer.

When you click on ‘Add Media’, the Media Library will open in a new window. You can select an existing
image / document from an already existing repository or alternatively upload a file from your computer
(see Figures 6.10 and 6.11). Once selected, click on ‘Insert into page’ button at the bottom-right of the page.
You will now be able to see the image or document in your editor. Click on ‘Publish’ to update your page
with the latest changes.

Note: click on ‘Make revision’ button to submit to workflow if unable to publish.

Add Media x
Upload Files | Media Library Select file )
Al mediatems ¥ All dates Search media items.. ATTACHMENT DETAILS

- ~ = Web_Content Policy.pdf
E'R 3 = Aor 9,2019
ation.for-Stafr ’ = 2108
i-access-form- R L \ L - Delete Permanenty

a-content.
ntributor-or-

Web_writing-user- s eftor-wi-two- | URL | hitpistaffoortal-sto.curtinec
quide-v2.pdf df ges.docx

Title | Web_Content Policy

Caption

Deseription | Web content policy

JATTACHMENT DISPLAY SETTINGS

LinkTo | Media File v

hitp/sstafiportal-stg.curtinec

Size | Medibm-212%300 ¥

Media metadata

L)
assure

pac-vc-awards-
exemplar-

nomination-
individual-5.pdf

1selcted D Insert into page button
Figure 6.10 Media Library

Add Media
Upload Files = Media Library
All media items ¥ | | All dates A

-

Figure 6.11 Media Library close up
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6.3.2 Media metadata

On the right side of the Media Library window, you can see the media metadata including:
e The URL

o Title
e (Caption
e Alt text

e Description

The URL

You can use this URL link to copy and paste anywhere in the editor if you choose to do so. This link can be
useful if you are creating call to action buttons, or related links that require a link to download a pdf
document for example.

Title

The title is the only attachment detail required by WordPress. Title defaults to the name of the original file
but should be changed to a descriptive title that makes sense to you and your team. Think about being able
to search for this item in a few months. Which words would you use?

Caption
The caption is the text that is displayed underneath the image. You don’t have to use captions unless you
are attaching an image representing people or events you would like your readers to know about.

Alt Text

The Alt Text is mandatory for images on the web, but is often overlooked. The alt attribute is the text that
displays when an image does not load. The general rule is to describe these images to your readers who
can’t see them.

You can find out more about effective use of “Alt text,” or in Curtin style guides.

Description
The purpose of this field is to add descriptive text that will be stored as post content for the attachment
post. That means if someone lands on the attachment post page for the image they will see the long
description.
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https://blog.hubspot.com/marketing/image-alt-text

6.3.3 Adding videos

You can add videos by copying and pasting youtube URL into the editor. Once you press enter, you will be
able to see the video in line with text.

Another way of adding videos is by using a Video Panel page module which will allow you to include text

adjacent to the video content with an ability to include a link (see Page Modules section on how to work
with page modules).

2018 winners announced!

Nominate for the VC's Excellence Awards for Professional Sta... 4

Congratulations to the 2018 winners who were announced at an
awards presentation ceremony attended by 400 staff on 8 November
2018,

The VC's Excellence Awards for Professional Staff were established
in 2015 to recognise the significant contribution that professional
staff make towards achieving Curtin’s vision. These awards have
been developed to complement the existing Vice-Chancellor Awards
for Research and Teaching staff.

The Professional Staff Awards celebrate individuals and teams who
have performed above and beyond the normal requirements of their
position and have demonstrated a commitment to innovation,
collaboration, leadership or service whilst embracing our shared
values.

Figure 6.12 Video Panel page module
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6.3.3 Paragraph Menu

File v Edit+ Wiew~ Insert* Format> Tools> Table »

Paragraph s B I €€ =~ £~

m
i
o Il

%

Paragraph r

Heading 2
Heading 3
Heading 4

Heading 5

Figure 6.13 Paragraph Menu

The paragraph menu is used to format the web page text based on the styles used by the current WordPress
theme. Subheadings within the website content need to be formatted in line with proper semantic HTML.

What is proper semantic HTML?

Headings, paragraphs, lists and links are all important structural elements of web pages. Their main purpose
is to help readers interpret what the text on a web page is about, in other words, to define its semantic
function.

Web pages that are properly structured are not only easier to scan, they are also more accessible for visually
impaired and blind users using assistive technology. Screen readers can jump from heading to heading
helping users navigate web page content. Search engines also give greater weighting to keywords within

headings.

Utilising the correct H1, H2, H3 headers in order will help your page perform better.

Considerations about headers

Avoid linking to other content or pages using headers — a heading should define the content below it not
link to other content. Avoiding to do so will confuse you and your readers.

Avoid using headers for text that you want to emphasise, such as block quotes.

6.3.4 Formatting options

For formatting options in the Visual Editor, and various editing toolbar functions, see table in Figure 6.14.
You will find that most functions resemble those in MS Word.

Note: Unlike in MS Word, you can’t use ‘tab’ on your keyboard to increase or decrease indentations.
Pressing a ‘tab’ bar in WordPress will navigate from one button or editing function to another.
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Symbol Function Keyboard shortcut

B Bold text Ctrl+B
T Italic text Ctrl +1
¢« Block quote Shift + Alt + Q
=iy e Bulleted list / numbered list
= = = Text alignment options shift + Alt + L (align left)

Shift + Alt + C (align centre)
Shift + Alt + R (align right)

2 Insert / edit link
0 Remove link Shift + Alt + S
Undo / redo Ctrl + z (undo)
Ctrl + Y (redo)

= = Increase / decrease indent

ﬁ Paste as plain text

o Clear formatting

0 Special characters

- Insert read more tag Shift + Alt+ T
A~ Text colour

) Keyboard shortcuts Shift + Alt+ H
v Table

Figure 6.14 Formatting options as seen in the Visual Editor
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Adding links

To insert or edit links, select text you wish to turn into a link, click on ‘Insert/edit link’ button. You have an
option to paste external URL or search for a page within your WordPress website. Once you have finished,
click ‘Enter’ to apply the changes (see Figure 6.15)

3 Content - wysiwyg

Content

€7 Add Madia

File  Edit* View* Insert* Format* Tools » Tabla =

Pragaph  + B I & =+ =+ E = E[L|8 N 2
Fomats R B R O 0= A H- 0

Services
Services i } click to apply link changes
I Health services Page ™
Research Seraces Team transformation = an update Meves
The Rezearch Senaces Team is transforming Mt
Senices Page
Redisction in mail senices MNewes
Potabie water and fire main services disruption MNews
Future Student Senaces opening hours Mews

EII._.I £lased o dates spd Lpntsa senares im Inriss '\:a-'" :ul o '

PsA

Figure 6.15 Add and apply link changes

Note: There is an optional settings button adjacent to ‘Enter’ if you wish to open the link options in
a new window.

Adding email

To add an email address, type in the full email address, select the text and click on ‘Insert/edit link’ button.
WordPress will automatically convert it into an email link, adding the necessary code for you.

File + Edit* View~ Insert* Format+ Tools+ Table -

Paragraph *r B I 8 =» =+ =

[ih
lils
%)
§S
i
[

Fomats* = S EH ¢ O = A~ H~- @

Senvice.Desk@curtin.edu.au

Figure 6.16 Adding e-mail
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Creating anchors

Anchors can be a useful tool to direct your readers to a particular point in the page, such as a subheading
for example. To create anchors, follow the steps from this example:

1. Given that the highlighted area in Figure 6.18 is the chosen location for your anchor, place the
cursor before the first word. Click on ‘Insert > Anchor point’ from the editor’s menu. You will be
prompted to name your Anchor ID (see Figure 6.17). In this example, Anchor ID is a word ‘third’.
You will notice an anchor icon appearing in this location.

2. Next, select the text which you would like to link to the anchor, click on ‘Insert/edit link’ widget,
and copy and paste the URL from the page you are currently on. Add your anchor ID name (‘third’)
following a /#:

https://yourUrl/#third

Figure 6.17 Naming your Anchor ID

Q7 Add Media
File v Editv Vieww Insert v Formatv Toolsv Table v

Paragraph 'BI“";E'::i::Eg«\ = R

Fomatsv ¥ SR ¢ Q E A v @Hv @

« first tag
« second tag
« third tag

first

Figure 6.18 Placing Anchor
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Creating buttons

To create a button, you will first need to create a link. Select the linked text, and click on ‘Formats’ from the
toolbar. You will have an option to select a button type from the list.

File = Edit+ W“iew> Insert* Format~ Tools Table »

PlR N a &

1l
|

Paragraph *+ B I & = -
Emds @00z A-m- e
I - curron

STANDARD

BLACK
BLACK TRANSPARENT

WHITE

Senvices YELLOW

staffportal-authoring.curtin.edu.au/services &* e ' SERVICES

Figure 6.19 Creating a button (black transparent type)

Creating tables

To create a table, select Table function from the toolbar. You will have an option to select the amount of
rows and columns you need (similarly to the way you can create the tables in MS Word). You can control
the table properties from the Table’s menu. There are options to control the table as a whole, or to

individually look at properties of each column, row or a cell.

f 8N = SR

Paragraph vy B I & =~ £~
Formatsv € F B 0 Q = A v [H+] O
Ef Table b
Table properties
Delete table
Cell
Row

m] . :
Column

Figure 6.20 Creating table menu
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To change the shading and border type of the entire table, select ‘Table properties’ and choose ‘Advanced’
tab. If you would like to change shading of a single cell or a row, select either cell or row properties from
the menu.

Table properties

General Advanced
Style background-color: #aeebcS; width: 1538p
Border style Solid

Border colar #000000 [ |

Background color #aeedcd

Cancel

Figure 6.21 Table properties
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(. Page modules

Page modules are content blocks that can be added to your web page. To add a page module, click on the
green ‘Add page module’ button located in the bottom-right corner beneath the Editor. When you click on
this button, a menu will appear displaying different modules available to be added to your page.

4 Content - wysiwyg
Content
07 Add Media Visual  Text

File + Edit * \iew * Insert * Format = Tools » Table =

[t
il
S
]
=F
i

Paragraph B I & =~ =~ =

Foomatsy 2 2 @B ¢ O = A v Hx @

B Acrordion

Comments @ Cards

E Content - Banner - BETA

Add comment
@ Content block

No comments yet. Content Box - BETA

H Content - wysiwyg

Events Calendar - BETA
hank you for creating with WordPress, Feature FAQ
Feature Banner - BETA
Flipping Cards

Grid ems - BETA

Figure 7.1 Page module menu

You will find that some modules are marked with a preview icon, while some are marked with words ‘BETA'. If you can
see the preview, you can safely assume that the Page module can be used, whilst the once marked ‘BETA” means that
the administrators are reviewing them. The Page modules are subject to minor changes/improvements as the WordPress
base theme is updated. This means that you might notice some interface appearance changes, however, you will not be
losing data.
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it Events

% WC's blog
Media Comments
= sA Sliders Add comment

Pages Mo comments yat.

Thank you for creating with WordPress.

Accordion

Undergraduate courses
Postgraduate courses

Enabling courses

Semester 2, 2018 Application deadline

Enabling Course for
Science, Engineering and
Health alternative

EN-
SCENHL

Figure 7.2 Page module preview

This course is no longer offered after August, 2018 Applicants are
recommended to apply for the UniReady Enabling Program as an Thumbnails

H Accordion

B Cards

B Content - Banner - BETA
@ Content block

Content Box - BETA

H Content - wyshwyg

Events Calendar - BETA

Feature FAQ

Feature Banner - BETA
Flipping Cards

Grid ltems - BETA

M List - dev

& Promo section
Search Bar

Slider - Banner - BETA
Slider - CTA - BETA

& Slider - Featured items
B social share banner
Spotlights

H Tab box - BETA

Video Panel

What's Happening

Apply Now Job Vacancies
Curtin Li plication
Festured N and Events
Home Page Block

Library Page Block

Most page modules utilise similar editing configurations consisting of two tabs. The first tab would always
epitomise the module you are working with (e.g. Accordion), whilst the second includes its options:

5 Accordion

Accordion Options

Module padding Heading Subheading

None | Reduced m opticnal optional

Content options

Alignment Open items
Hor Open accordions on poge load

alignment of module content.

Colours

Background

Heading - deprecated - use above option fields Subheading - deprecated - use above option ficlds

optional optional

Figure 7.3

Description

Accordion size

Set the maximum width of items

Small (320px) | Medium (640px) [REGENEE)

Description - deprecated - use above option ficlds

The most common option features include functions such as:
e Module padding — you can choose between three states (none, default, reduced)
e Heading and /or subheading — to appear specifically above the module
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e Description — you can use description text only if you use the heading, which will then appear
directly beneath.

e Content alignment — left or centre (default)

e Background colour (white, default, grey) — this colour determines the colour of the border
surrounding the module you are applying.

Once you have added a few page modules, you can swap their location, and you can choose to delete them
if you don’t like them.

Once you have made all changes to your page, click ‘Publish’ or ‘Make revision’ (depending on your content
contribution role).

7.1 Accordions

The Accordion is used to list multiple items, which can then be expanded out to display additional
information. An accordion can be used to compress content on a long page to reduce scrolling.

Accordions are designed for situations where you have a lot of content but are limited in space on page.
Also, they can be used to reduce navigation depth.

Where possible, avoid overusing accordions. Users tend to avoid browsing them so make sure if you have
to use them that they are clearly labelled.

To add to accordion, select ‘Add item’ and enter in the item heading and content. You can repeat this
process for additional items (See Figure 7.5)

pm—
Accordion

Undergraduate courses v
Postgraduate courses v
Enabling courses =
Semester 2, 2018 Application deadline
EN Enabling Course for This course is no longer offered after August, 2018. Applicants are
‘%C_ENHL Science, Engineering and recommended to apply for the UniReady Enabling Program as an
i Health alternative.

Figure 7.4 Accordion
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5 Accordion

Accordion Options
Accordion [tems

Heading * Content
7 Add Media Vieaat | [t
File v Editv View v Insert~ Formatv Tools Table v

Paragraph ¥ B I 66 = v = v = = & R =R

@

Formatsv & B ¢ Q = A v H~

Figure 7.5 Adding accordion items

The areas marked with a red asterisk are mandatory fields. If you leave these areas unpopulated, you will
not be able to validate your page, and you will be prompted to revise.

7.2 Content Box

Content boxes are commonly used for related links in the side bar, or they can be used as a part of main
text for housing buttons, or emphasising text areas. In the example below, ‘Related links’ text is inserted as
a heading in the options tab.

The links are inserted by selecting ‘Add content to box’ button, and then selecting ‘Links’.

Related links

Web toolkit >

Do you need a web 5

presence?

Gathering requirements >

4 Content Box - BETA A

Box Options
Content

Box contents
Image

Image + Text

Click the "Add content to box" button below to start ¢
Links

Figure 7.6 Content Box
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7.3 Content - wysiwyg

This is an alternative name for the Editor, which can be added after you add other modules to the page.

7.4 Link lists

You can create link lists in several ways. The easiest way is to create lists directly in the editor via bullet
points and inserting links into selected sections of the text. Second is by creating them in the Content Box

(see section 7.2). Third is via List page module:

List page module

The list page module enables you to show document type icons (e.g. pdf, xls, doc). This way of listing
linked attachments can enable your users to quickly locate the documents, whilst being able to distinguish

between file types.

To create a list, click on ‘Add page module’ and select ‘List’ from the menu. You can opt to add multiple
items and lists. To insert links to document attachments click on the ‘Select Link’ button.

4 List - dev

Lists Options

List
Heading Description
new sectio
“
Mo
List items

Icon Link Suffix

Add
additional
information
Toggle Select Link optional

Use automatic file detection, or specify an icon to use.

m Manual | MNone
Add item
Add list

Figure 7.7. Lists page module
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You will be prompted to insert URL. The list you are able to choose from represents pages internal to your
website. If you would like to use document links, paste the document URL you can obtain from the Media
Library (see section 6.3.1 and 6.3.2 about Media Library and Media metadata that explain how to obtain

this URL).

Link Text is the interactive text that will appear on the page (see Figure 7.9).

Figure 7.8

Insert/edit link
Enter the destination URL

URL

Link Text | link text

Open link in a new tab

Or link to existing content

Search

Mo search term specified. Showing recent items.
Disability-inclusive curriculum

Supperting students with autism

Providing accessible infermation and communication
Student disclosure of disabilities

Supporting students with Curtin Access Plans

Refer a student for support

Cancel

List title
List heading

List description

Link text [36kB]

Figure 7.9
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8. Publishing updates

Once a page is complete and ready to be published, click on ‘Update’ on the right-hand side of the page.
The content on this web page is now live and viewable to anyone.

Publish i

Preview Changes
? status: Published Edit
@ Visibility: Public Edit
i Published on: Apr 15, 2019 @ 15:48 Edit
'y’ Readability: OK

V’ SEC: Mot available

Move to Trash

Figure 8.1

To save (but not publish) the content, change the visibility option to ‘Private’ in the right-hand menu
above the Publish button.

Publish i

Preview Changes
9 status: Published Edit

@& Visibility: Public
Public

Password protected
(®) Private

QK | Cancel

m Published on: Apr 15, 2019 @ 15:48 Edit
E" Readability: OK

‘f SEC: Mot available

Move to Trash

Figure 8.2
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8.1 Making revisions

For authoring roles that cannot directly publish content, you will be prompted to make a revision once you
decide to edit a page (see Figure 8.3). This means that all changes that you make to a page will be submitted
for approval.

Make Revision

¥ou may not make changes to this published content. You must first
make a revision and then submit your changes for approval.

Figure 8.3 Make a revision window

If there are pre-existing revisions made to the page, you will be prompted to create either a new revision
or to work on the existing one. It is recommended that you select to work on the existing revision. When
you opt to create a new one, you will be taken to a blank page

Revision Already Exists

An active revision already exists for this article. Do you want to delete the existing revised article and create

Cancel No, take me to the revision Yes, delete it and create new one

a new revision?

Figure 8.4

Once you enter into the page, you will notice that the title of your page will indicate that it is a Workflow
Copy.

Edit Page

Copy of - WordPress page elements - WORKFLOW COPY

Permalink: http://staffportal-stg.curtin.edu.au/services/developing-portal-content/copy-of-wordpres.. .ts-workflow-copy/ | Edit

Figure 8.5

32



When you are ready to submit a workflow, click ‘Submit to Workflow’ button on the right side of the page.

Publish &

Save Draft Preview
?  Status: Draft
<& Visibility: Public
G‘j Readability: Needs improvement

F)"] SEC: Not available

Submit to Workflow

Figure 8.6

You will be prompted with a window asking you to nominate a Publisher, whose name you can select from
a list of available ones. These lists are useful in case that there are more than one publishers in your area.

Workflow : Editor Content Approval ¥
Step: Publish v
Priority : Mormal ¥
List of available Publishers Your assigned Publisher

Assign Actor(s) : Available Assii;ned

Publisher John = Publisher Jane

Publisher Wendy :D

Publisher Jacob

Publizher Rita
Publish Date: (7) | 04-Apr 2q, 2019 @ 10 03 clear
Comments :

test ccpyl

s
Figure 8.7
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You can locate your workflow submissions in the Pages section on your Dashboard, which state the
submission progress (i.e. pending, draft or approved).

& MySites i} StaffPortal [Staging] =+ New STAFF PORTAL [STAGING] Howdy, 1111116 [l

v Help *

Workflows Pa ges
bt et ANl {(177) | Mine (9) | Published (153) | Drafts (12) | Pending (5) | Trash (4) | Ready to Publish (1) | Nested View | Comerstone content (0)
Search Pages
Bulk Actions ¥ | Apply All dates ¥ Al Categories ¥ All SEO Scares ¥ All Readability Scores v || Filter
S 171 items 1 of 9| 3 »
% VCs blog Title Author Categaries Tags L] Date ¥ 9 @ V.
REEE Copy of — WordPress page elements  111111b = — — Last 1 [ ] [ ]
— WORKFLOW COPY — Draft Modified
2019/04/23
Copy of - WordPress page elements  111117b PaC_Team — — 1 @ @
- WORKFLOW COPY — Pending
Copy of — Web writing and content 111111k = — — 2 a [ ]
creation — WORKFLOW COPY —
E TablePress Draft
s Profile
Copy of — Pay information — 111111b 2(_Team — — 2 ® ®
O « WORKFLOW COPY — Draft

Figure 8.8

8.2 Approving workflows

Content contributors who have nominated Publisher roles have the ability to approve workflows
submitted by Editors.

You can check for pending submissions in Dashboard. If there are outstanding tasks, you will see a
highlighted number next to the ‘Workflows’ button on the left hand side of the window.

#§ Staff Portal [Stagingl == MNew STAFF PORTAL [STAGING]

* Check here for outstanding Workflows

Dashboard

Activity A

Recently Fublished

Mar 13th, 11:12 am Home

Mar (no title)

WMar (no title)
Pages R —— - | —

Oct 2nd 20013 11:24 pm Second VC post
TablePress Nov 20th 2017, 431am 1 October 2018 example post
Profile Recent Comments

From John Smith on 18 February 2019

Thanks for your feedback.

Figure 8.9
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Hovering a mouse over a selected list item will reveal options to take one of the following actions on a
pending workflow:

e Edit —you can make changes before signing off

e View —you can view a live version of the workflow submission

e Sign off — you can choose to approve (publish) or reassign the workflow
e Reassign — you can reassign to another Publisher

e Abort Workflow

e View History — you can view revisions’ history

% MySites @ Staff Portal [Staging] -+ New STAFF PORTAL [STAGING] Howdy, 111111c [l

Inbox

Displaying 1-4 of 4

View inbox of ¥ | Show

Post/Page Priority & Type « Author & ["f'_irrf]_lcw Category Due Date & Comments
St
@ Dashboard
Copy of - New staff - WORKFLOW COPY — m Page 111111b Editor PaC_Team n
= Pendin Content
03 Media d i 1
Approval (1)
I Pages [Publish]
E TablePress Copy of - Training demo page for People & Page 111111k Editor PaC_Team n
Culture Team - WORKFLOW COPY — Pending Content
s orofile Approval (1)
- [Publish]
0c b Copy of - Wellbeing - WORKFLOW COPY — Page 111111b Editor PaC_Team n
Pending Content
Approval (1)
[Publish]
Copy of - WordPress page elements - Page 111111k Editor PaC_Team n
WORKFLOW COPY — Pending Content
Edit | \ Sign Off  Reassign | Abort Workflow Approval (1)
View History [Publish]
. Workflow
Post/Page & Priority & Type Author « a Category Due Date «  Comments
[Step]
Workflow viewing and action options Displaying 1-4 of 4

Figure 8.10

8.2.1 Signing off a Workflow

Signing off a Workflow will prompt you to make a decision to either complete a workflow or take further
action, marked as ‘Unable to complete’.

Complete

Completing a Workflow is a final step of your approval. Signing off will integrate revised article content
into the original (published) page. This action will take place immediately or on the scheduled date / time.

The approved Workflow will now appear in the Workflow History (located beneath the Inbox), with a
result marked as ‘Workflow Completed’.
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Sign Off

This is the last step in the workflow. Are you ready to complete the worlkflow?

Action : Complets

Publish : Immediately 04-ppr ¥ 29 || 2019 @ 19

Signing off will copy over the contents of this revised article to the comresponding published/original
article. This will happen either immediately or on the scheduled date/time.

Figure 8.11

#i Saff Portal [Staging] =+ New STAFF PORTAL [STAGING] Howdy, 111111c [l
Workflow History Workflow completed
Displaying 1-49 of 49
View Post/Page Workflow H ¥ | Filter - | Download Workflow History Report
Title & Actor Workflow [Step] 4 Assigned date & Sign off date Result Comments
Dashboard Copy of - WordPress 111111 Editor Content Approval  April 29, 2019 10:33 am April 26, 2079 11:11 am Workflow u
page elements - (1 completed
: WORKFLOW COPY [Publish]
£ Media
Copy of - WordPress 111111k Editor Content Approval  April 29, 2019 10:03 am April 29, 2019 10:03 am Submitted n
# Pages \
page elements - U]
TablePress WORKFLOW COPY [Submit to Workflow]

Figure 8.12

Unable to complete

If you don’t want to approve the changes you can reassign the Workflow by selecting ‘Unable to
Complete.” You can choose to reassign back to the author of the post, or to someone else (See Figure 8.7
— you will be prompted with the same options, with the Action marked as ‘Unable to Complete’)

Workflow Abort

If you abort a workflow, you will be prompted to submit a comment. Once aborted, the post author will
receive an email with the page details and options to contact the administrator for further questions.
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9. Simultaneous editing

If another user is already working on a page, you will be notified, and prompted to either take over, preview
the page or work on another page.

111111¢ is already editing this post. Do you want to

take over?

All Pages Preview Take over

Figure 9.1
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